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A SPY’S SOJOURN

At the request of our army’s Marshal, | have ventured into
enemy domain. My path has taken me across woods and
lakes under the cover of darkness, and around black mines
looming like markers of death before me.

The enemy’s war councils are at a frenzied pitch; messen-
gers scuttle between the camps. Scouts prepare to unearth
our most precious secrets. | have seen Captains and Colo-
nels in bivouac, their plumed helmets circling the night fire. |
have eavesdropped on Majors, and watched Miners practice
defusing bombs.

| once approached the fire where our enemy’s Marshal sat
with his General, wrapped in overcoats of winter. Focused
on the great map, their eyes gleamed confidently as the
smoke rose high. Their voices were mere whispers as they
drew up the final plans.

Had | been detected, the execution of my fate would surely
have been swift. Yet, | worked in the absence of undue
haste, knowing the value of my report. Nothing would sad-
den me more than to have returned flush of cheek, yet

bearing but a sketch in the sand, to be washed away in the
incoming tide.

If our forces be sure in the execution of our plans, the
enemy’s doom is surely sealed.




OVERVIEW

Stratego, adapted from the popular board game of the same
name, is a contest of wills between two evenly-matched
armies meeting on a rugged battlefield. The game empha-
sizes careful planning, thorough deception, and well-timed
boldness. The object is to capture the opponent’s flag
before he captures yours.

Skillful play depends upon the application of memory. At
first, guesswork prevails. Each side probes the other's
defenses, seeking to reveal the identity of key pieces, un-
cover mines, locate spies, and discover likely attack routes.

When you reveal an opponent’s piece, you mentally record
its location. Memory plays an increasingly important role as
a game progresses and as your opponent shuffles his pieces
to and fro. Move matches countermove as the battle unfolds
to its necessary climax.

Each battle is different — even those which feature similar
army formations. Each demands your full attention, and
presents new challenges. To capture your opponent’s flag,
you must have an adventurer’s spirit and a tactician’s mind.
This is the essence of Stratego.
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GETTING STARTED

In this section, we describe the nuts-and-bolts of getting
started: system requirements, installation, disk backup,
booting, and copy protection.

System Requirements

Stratego runs on any member of the Macintosh family of
computers with at least 1MB of RAM and 128K of ROM.
The game requires System 4.2 or later.

'Note: We recommend that you r.;lay ihé"gén'ie from a
hard drive, if you have one. Follow the directions in
‘ the Installation section on page 2.

User Requirements

Before you start playing the Macintosh version of Stratego,
you should know how to:

+ Use the icons on the Macintosh desktop.

» Open and close Macintosh documents and folders using
the Finder.

« Point and select with the mouse, and understand basic
Macintosh terms and techniques such as click, double-
click, and drag.

« Scroll in a window or list box using the scroll bars and the
scroll box.

« Pull down menus and choose commands.

« Find files in the hierarchical file system.

You should also understand Macintosh terms such as dialog
box, list box, folder, and button. For information on any of
these items, see your Macintosh owner’s guide.
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Installation

Stratego comes with two disks. If you're playing in Black &
White, you only need Disk 1. If you're playing in Color,
you’ll need both disks.

To install Stratego to your hard drive:

1 Create a new folder on your hard drive.

2 |Insert Stratego Disk 1 in the disk drive.

3 Double click on the Stratego disk icon to open a display
of the disk’s contents.

4 |If you're playing in Black & White, drag these game files
— Stratego, Stratego Help and Stratego Sounds —
from the Stratego disk to the new folder.

If you're playing in Black & White, you're ready to boot the
game from the hard disk. If you're playing in Color, read on:

5 Drag the Color Data 1 game file from Disk 1 to the
new folder.

6 Now eject Disk 1, and put Disk 2 in the disk drive.

7 Double-click on the Stratego disk icon to display the
disk’s contents.

8 Drag the Color Data 2 game file from Disk 2 to your
Stratego folder.

Backup

We recommend that you back up your copy of Stratego
before beginning play. Copy the game files to a blank,
formatted and labelled 3.5" disk. (For disk copy procedure,
consult your Macintosh owner’s guide.) When you're done,
place your original disk in a safe place.

Starting Stratego

If you have a hard drive system:

1 Turn on your computer.
2 Open the folder that you created containing the Stratego
files. (See Installation above.)
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3 Double-click on the Stratego application icon.

4 When the “Spy’s Secret Report” appears, consult your
codewheel to decode it (see Spy’s Secret Report
below).

5 The title screen appears, and Stratego’'s theme music
plays. When the game board appears, begin Game
Setup (see the Game Setup section for more).

If you have a floppy disk drive system:

1 Put your system disk in the disk drive and turn on your
computer.

2 Put Disk 1 into the disk drive and double-click on
the Stratego disk icon to open a display of the disk’s
contents.

3 Double-click on the Stratego application icon.

4 When the “Spy’s Secret Report” appears, consult your
codewheel to decode it (see Spy’s Secret Report
below).

5 The title screen appears, and Stratego’'s theme music
plays. When the game board appears, begin Game
Setup (see the Game Setup section for more).

Note: To use on-line help during play, select Help
(from the Apple Menu). This will display a list of Help
Topics with accompanying text. For a full listing of all
menu items, see Appendix: Menu Overview.

Spy’s Secret Report

Stratego uses the “Spy’s Secret Report” and a codewheel as
copy protection. When the Spy’s Report appears, your
screen will show four elements — two icons, two words —
and a box to type in.

1 Match the left-most icon on the screen to the same icon
on the outer ring of the codewheel.

2 Now find the second icon from the left on the screen, and
match it to the same icon on the middle ring of the
codewheel.



Stoatego

Sp{r’s Secret Report (continued)

3 Rotate the middle ring so the second icon lines up under
the first icon.

4 Next, find the left-most word on the screen, and match it
to the same word on the edge of the inner ring of the
codewheel.

5 Rotate the inner ring so the word is lined up under the
two icons (which are already matched and lined up).

6 Look for the second word on the interior of the inner ring;
there is a number in the cut-out window immediately
above the word.

7 Type in that number and press Return. The game will
now load.

GAME SETUP

Stratego begins with two armies of forty pieces facing each
other on a square field of battle. Two lakes in the center

of the board divide it into halves. The computer's pieces
occupy the top half, while your half is empty until you choose
a setup for your army.

Your pieces occupy the piece box at screen right, which
empties when you complete your setup procedure. During
play, pieces lost are returned to the piece box.

Choosing Board, Background and
Piece Sets

Both the Black & White and Color versions of Stratego let
you choose from among several different boards, back-
grounds and piece sets. Just pull down the Options menu
and choose the following:

Board...
The Board... option lets you change either the Buard Type
or the Background Fill.
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To change the Board Type, click & hold on the box that
lists the current board type; this displays a pop-up menu
that lists other available board types. While still holding
down the mouse button, move the cursor arrow to the
board type you want, then release the mouse button. A
portion of the new board will appear in the Preview Box.

To change the Background Fill, click & hold on the box
that displays the current piece box background pattern/
color; this displays a pop-up palette that shows other
available patterns/colors. While still holding down the
mouse button, move the cursor arrow to the background
you want, then release the mouse button.

Color Macintosh owners may also modify the color of the
Background Fill by clicking on Choose Color...and then
adjusting the color using the color circle.

After either choice, you must click on OK to enact the
change, or Cancel to return the board/background
settings to what they were before you opened the Board...
dialog box.



W Fig. 2. "Choose Piece Set” Screen

Piece Set...

The Piece Set... option lets you change piece sets for game-
play. Just click & hold on the box that lists the current piece
set: this displays a pop-up menu that lists other available
piece sets. While still holding down the mouse button, move
the cursor arrow to the piece set you want, then release the
mouse button. Samples of the new set will appear in the
Preview Box.

Color Macintosh owners may also click on the Color Pieces
box to enable selection of black & white pieces.

Choosing a Setup

You can set up your army'’s pieces in any of the following
ways:

« Click and drag individual pieces from the piece box to
empty squares on your half of the game board. Continue
until all pieces have been placed on the game board.

Simply select Save from the File Menu, and type in a
name for your setup.

« Select Open from the File Menu to select a saved setup
you've previously created.




« Select a “packaged” game setup by choosing Use
Setup... from the File Menu. Scroll to view the available
setups, and select one. Choose the Flag Orientation
(left or right). All forty pieces are placed automatically on
the board.

« Choose either Use Setup... or Open, then modify an
existing setup by redistributing individual pieces. To
replace a piece (let’'s call it piece “A”) with another piece
(piece “B”), do the following:

1 Move piece “A” to the Piece Box.
2 Move piece “B” to the empty square left by the removal
of “A”.

You can move any number of your pieces from the board to
the Piece Box in the course of modifying an existing game
setup.

Opponent Level

You can set your opponent’s skill level before starting a
Single Game or the first game of a Campaign. The default
selection is Sergeant, a good choice if you've never played
Stratego before. As your own skill increases, you may want
to use Opponent Level to raise the level of your opposition.

To set your opponent’s level:

1 Pull down the Game Menu and highlight Opponent
Level.

2 When the adjacent pull-down menu appears, select one
of the five skill levels. In order of increasing difficulty,
they are:

Sergeant
Major
Colonel
General
Marshal
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" Opponent Level (continued)

3 During play, your opponent’s skill in tactics and strategy
will reflect the level selected.

4 The Opponent Level you select remains in effect for
ensuing games. You can raise or lower the level before
the start of any new game.

| Note: You cannot change the opponent’s level once
‘ a game begins.

Pieces and Ranks

You begin play with forty pieces in your army. 33 of these
are moveable, and are ranked from #1-9/Spy. Of the re-
maining seven, six (6) are Bombs, and one (1) is your Flag.
These seven pieces cannot be moved once play begins.

Each moveable piece is ranked. Powerful pieces (e.g., the
Marshal) are assigned low number ranks, while those with
less clout have higher number rankings.

The moveable pieces, their names, quantity and ranks are:

Piece Quantity Rank
Marshal 1 #1
General 1 #2
Colonel 2 #3
Major 3 #e
Captain 4 #5
Lieutenant 4 #6
Sergeant 4 #7
Miner 5 #8
Scout 8 #9
1

Spy
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Rules of Rank
The rules of rank are as follows:

« Order of Rank. A Marshal (#1) outranks a General (#2),
and so on. A Spy is the lowest-ranking piece.

« Special Miner Privilege. A miner defuses a bomb by
striking it. All other pieces are lost when attacking
bombs. The miner then occupies the bomb’s former
square.

« Special Scout Privilege. Scouts can move any number of
available open squares (in any direction but diagonally).
When you select Move & Attack (see Preferences...
in the Playing Stratego section), the Scout can cap a
multiple-square move by attacking an opponent’s piece.
But remember: Moving a Scout more than one square
immediately discloses its identity.

« Special Spy Privilege. Since the Spy lacks numerical
rank, any piece attacking it causes the Spy’s removal
from the game board. However, the Spy can remove
a Marshal from play ifthe Spy attacks first.

PLAYING STRATEGO

Once you've chosen a setup, you're ready to match wits
with your opponent on the field of battle. Play begins when
you move one of your front-row pieces towards the
opponent’s ranks. The first player to capture the
opponent’s Flag wins the game.

" Note: Once hlay bégins, you may not modify rules or
opponent level.

During play, you alternate turns with your computer oppo-
nent. When it's your turn, you either (1) move a piece into
an empty square, or (2) attack an opponent’s piece.

If you're new to the game, we recommend that you play a
Single Game using Standard Rules (both found in the Game
Menu). Once you've gained a measure of experience,
proceed to Campaign and Tournament play. Use the Game
Menu to change the type of play.
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Standard Rules

You'll typically use the Standard Rules (the Game Menu)
when playing Stratego. The standard rules are faithful to
the Stratego board game'’s rules for movement, attack and
SO on.

At other times, you may want to use special Preferences or
Tournament Rules; see the Preferences... and Tournament

Rules sections at the end of PLAYING STRATEGO for
more information on activating these rules options.

Moving Pieces

During each turn, you move one of your pieces one square
at a time—uwith the exception of the Scout.

These specific rules apply to movement in a Standard Rules
game:

* You can move a piece forward, backward, or sideways —
but not diagonally. Pieces cannot move onto or jump
over either of the “lakes” in the center of the board.

« Two pieces may not occupy the same square
simultaneously.

* No piece (including Scouts) may move through or jump
over an occupied square.

« The Flag and Bombs cannot be moved during play.

« A piece cannot move back and forth between the same
two squares in three consecutive turns.

» No player can “pass” a turn; a player unable to move any
of his pieces forfeits the current game.

Attacking the Opponent

Your piece can attack an opponent’s piece when they
occupy adjacent squares. However, a piece bordering on
an enemy’s piece is not required to attack.

To attack your opponent, simply move your piece onto
the enemy-occupied square.

10



" Note: Since all diagonal movement is forbidden, 7
diagonal attacks are not possible.

When you attack an opponent’s piece, the ranks of both
pieces are revealed. The higher-ranked piece (bearing

the lower number) wins the engagement, and the loser is
removed from the board and placed in the Piece Box. When
equals collide, both are eliminated from play.

In Standard Rules, a victorious attacker occupies the square
of his vanquished foe, while a triumphant defender stays in
his square. (See Preferences... below for an exception to
this rule).

Winning a Game

When one of your pieces moves onto the square where the
opponent’s flag sits, you win the game. You lose if the
opponent captures your flag.

Another victory condition ensues when the opponent is
unable to move any pieces, though you have yet to capture
his flag. Should you find yourself in the same predicament,
you lose.

Preferences

You can vary the Standard Rules by selecting Preferences...
from the Game Menu.
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Fig. 3. Game Preferences Dialog
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- Preferences (continued)
To set special game or rule preferences:

1 Pull down the Game Menu and select Preferences....

2 When the Game Preferences window appears, view the
default selections.

3 Change game or rule preferences by clicking on the
button next to the preference you want to choose.

4 When you're satisfied with the new preferences, click
on OK.

Here are the rule preferences you can choose:

« Scout’s special move. If you choose Move & Attack,
your Scout can make a multiple-square move and attack
on the same turn. Move Only lets your Scout make mul-
tiple-square moves, but he cannot attack at the end of
such moves. He can only attack in the same manner as
other pieces, by moving one space during a turn onto an
adjacent enemy-occupied square.

+  When defender wins. When a piece is attacked, and
wins the encounter, Standard Rules dictate that it stays in
its own square (the default setting). But you can also
choose the Move to Attacker’s variation — if the defender
wins an encounter, it automatically moves into the
attacker’'s square.

You can also use the Preferences ... option to change
game preferences:

+ Player army. Lets you change the color of player
armies.

» Sort pieces by ... Choose Capture Order to place cap-
tured pieces on the Piece Board in the order they were
defeated in battle. Choose Rank Order to display cap-
tured pieces in order of their rank, from highest to lowest.

Selected rule preferences apply for the duration of the

ensuing game. However, you can change piece colors
during a game.

12



Tournament Rules

When you're ready for the extra challenge which experience
demands, you can select one or more of three tournament
rule variations (only available when playing a single game).
To activate tournament rules:

1 Select Tournament Rules from the Game Menu.
2 When the Tournament Rules dialog appears, click on the
box adjacent to the rule(s) you wish to apply to play.

You deactivate tournament rules before the start of any
game by deselecting any of the rules in the Tournament
Rules dialog, or by selecting Standard Rules. Once you
begin play, the rules are set for the duration of the current
game.

The Tournament Rules options are:

Aggressor Advantage. When activated, awards victory to
the attacking piece when equally-ranked pieces do battle.

Silent Defense. When selected, Silent Defense conceals
the identity of the piece attacked. The rules for winning the
engagement do not change. Exception: When a Scout
attacks, the rank of the defending piece is revealed.

Rescue. When Rescue is active, you can rescue a captured
piece by moving onto a square in your opponent’s back row.
Now, select a piece from the piece box and place it in an
empty square on your half of the game board. These restric-
tions apply:

« Scouts cannot rescue other pieces.

*  You can’t rescue bombs.

* You may rescue a maximum of two pieces during
a game.

» |If you make two rescues during a game, two different
pieces must execute the rescues.

13



Campaign

Unlike a Single Game, a Campaign consists of five “battles”
— individual games whose combined results determine the
outcome of the campaign. Naturally, each successive battle

In a campaign is more taxing; each battle also uses different
Tournament Rules (see Tournament Rules on page 13).

To win a campaign, you must win each individual battle.
When you lose any game, the campaign is over.

To start a campaign:

1 Pull down the Game Menu and select Campaign.
2 Choose New Game or Use Setup... from the File Menu
to begin the campaign’s first battle.

If you choose Single Game while a Campaign is in progress,
you’ll be prompted to save the current campaign.

Here are the Tournament Rules that apply to each game
within a Campaign:

First game Standard Rules
Second game Aggressor Advantage activated
Third game Silent Defense activated

. Fourth game Rescue activated, plus randomly

activates either Silent Defense or
Aggressor Advantage

Fifth game Aggressor Advantage, Silent Defense,
Rescue activated

14




The Statistics Box

The Statistics Box displays various bits of information that
you may find useful in the course of the game. Pull down
the Options Menu, then use the Display Windows sub-menu
to show or hide the Statistics Box at any time.

Important Note: /f you have a 9" monitor, the Piece !
Box and the Statistics Box will overlap! To see either

box in full, just click on open space in the one you

want to see.

Campaign
T

Rank

t —— Pieces Remaining

Rescues Remaining

Tournament Option Indicators
Fig. 4. Sub-Screen Shot of Statistics Box

Rank
Displays the rank of the piece you are moving.

Turn

Indicates the number of turns taken thus far in the game.
(A “turn” includes both your move and your opponent’s
matching move.)

Campaign

If you are playing in Campaign Mode, this indicator tells you
where you are in the 5 game series.

15



Tournament Option Indicators

The small indicator boxes below A, D and R (see Fig 4) light
up whenever the corresponding Tournament Rule is active:

A = Aggressor Advantage
D = Silent Defense
R = Rescue

Rescues Remaining
The number (see Fig 4) indicates how many rescues each
side has left.

Pieces Remaining

Shows the number of pieces still active (see Fig 4) for
each side.

16



APPENDIX: MENU OVERVIEW

There are five menus in the Stratego menu bar: the Apple
Menu, File Menu, Edit Menu, Game Menu, and Options
Menu. Each contains one or more items or commands
relevant to game play.

The individual menus and the options applicable to the
game are:

Apple Menu

You use the Apple Menu to get information about aspects of
Stratego.

« About Stratego: Select this to review game credits.
* Help: Choose Help to view a full list of Help topics
during play.

File Menu

Use the File Menu to reset the board for a new game,
choose from existing board setups, and manage game files.

 New Game: Select New Game to reset the pieces and
the game board for a new game. If a game is in prog-
ress, you are prompted to save the current game.

* Use Setup.... Choose Use Setup... to view a list of
Stratego’s preset setups for your army. (The computer
sets up its side independently.) When you choose one of
these setups, your pieces are placed automatically.

« Open.... Select Open... to return to previously saved
games or setup files you've created. Play resumes from
the point where you saved the selected file.

« Save: Choose Save to save the current game or setup
to disk. Saved setups are represented by a Spy icon,
and saved games by the Flag icon.

« Save As.... Select Save As... to save the current setup
or game to disk under a different name, and create a
backup file.

*  Quit: When you choose Quit, you end the current game -
and exit to the Finder.

17
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Edit Menu

You use the Edit Menu to undo moves during play.

« Undo Move: Select Undo Move to erase your last
move. If your opponent has made a subsequent move,
selecting Undo Move takes back both moves. The
option is disabled when Undo Move is not appropriate.

Game Menu

Use the Game Menu to choose modes of play, your
opponent’s skill level, game rules, and preferences:

- Demo Game: Runs a demonstration game in which the
computer controls the pieces of both sides.

- Single Game: Sets play to a single-game mode. Until
you change to another mode, Single Game prevails each
time you re-start play.

« Campaign: Sets play to Campaign Mode.

»  Opponent Level: Allows you to set the playing ability of
your computer opponent.

« Standard Rules: Select to apply Standard Rules to play.

] Note:_ﬁules may not be chaﬁééd during piﬂay.“

+  Tournament Rules: Displays a dialog to let you select
rule variations for tournament play.

« Preferences: Select to specify game and rule variations
(see the Preferences section under PLAYING
STRATEGO for more information).

18



Options Menu

Use the Options Menu to select options affecting sound,
piece movement and board display, and special items such
as Instant Replay.

« Instant Replay: Select Instant Replay to review your
opponent’s last move.

« Start Game Over: Restores the current game to its
initial setup, so you can replay it.

+ Reveal All Pieces: Reveals the rank of all opponent’s
pieces. When you select this option, you forfeit the
current game.

« Sounds: Toggles game sounds and music on and off.

+ Messages: Toggles error messages on and off; when
selected, displays message in response to any illegal
move.

+ Drag Moves: If selected, releasing the mouse button
when a moved piece is over a designated square con-
firms the move; otherwise, you must click the button to
set a piece in a square.

« Display Windows: Displays or hides the various game
windows.

+ Clean Up Windows: Restores any moved windows to
their default position.

« Board...: Displays a dialog to let you change the game
board and background pattern.

« Piece Set.... Displays a dialog allowing you to select a
different piece set.

19
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ACCOLADE CUSTOMER SERVICE: (408) 296-8400

N If you need help with this — or any other — Accolade product, please give us a call
between the hours of 8am and Spm (Pacific Standard Time). Be sure you are at your
- computer when you call. We'll do everything we can to solve your problem or answer
your question. Or write to us at:
Accolade
Attn: Customer Service

550 S. Winchester Blvd., Suite 200
San Jose, CA 95128

If you have a modem, you can call and log-on to Accolade’s Bulletin Board for instant
hints and other information. You can also leave guestions about any Accolade game;
they'll be answered by Accolade’s technical support representatives. The number is

408-296-8800. Our settings are 300, 1200, 2400 baud; 8 Data; No Parity; 1 Stop Bit.

DO YOU WANT TO BACK-UP YOUR DISK?

We know you're concerned about disk damage or failure. So feel free to make a
back up of the game. See your computer manual for details about saving disks. If
you lose the off-disk copy protection scheme, please send us $15 and we'll send you
a new one. If it's destroyed, send us the remains, and we'll give you a replacement,

YOUR DISK CARRIES A 90-DAY WARRANTY
Accolade, Inc. warrants for a period of 90 days from the date of purchase by the
———— | original purchaser of the Software that the recording medium on which it is recorded
90 will be free from defects in materials and workmanship. Defective media which has
not been subjected to misuse, excessive wear or damage due to carelessness may
be returned during the 90-day period without charge.

After the 90-day period, defective media may be replaced in the United States for $10
(plus 7.25% sales tax if the purchaser resides in California). Make checks payable to
Accolade, Inc. and return to the address above. (To speed up processing, return only
the di I ials )

LICENSE AGREEMENT and LEGAL MUMBO JUMBO

This computer software product (the “Software”) and the user manual are provided to
the Customer under license from Accolade, Inc. and are subject to the following
terms and conditions, to which the Customer agrees by opening the package of the
Software and user manual and/or using the Software. Granting of this license does
not transfer any right, title or interest in the Software or the user manual to the
Customer except as expressly set forth in this License Agreement.

The software and the user manual are copyrighted 1990 by Accolade, Inc. All rights
are reserved. Neither the Software nor the user manual may be duplicated or copied
for any reason. The customer may not transfer or resell the Software or user manual.
All registered trademarks and names are properties of their respective owners.

The remedies provided above are the Customer's sole and exclusive remedies. In no
event shall Accolade, Inc. be liable for any direct, indirect, special, incidental or con-
sequential damages with respect to the Software or the user manual. Except as
provided above, Accolade, Inc. makes no warranties, either express or implied, with
respect to the Software or the user manual, and expressly disclaims all implied
warranties, including, without limitation, the warranty of merchantability and of fitness
for a particular purpose.

WARRANTY
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